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Dreamweaver is the leading web design application for good reason: since its original release in
1997, it’s evolved from a relatively simple HTML editor into a highly sophisticated design and devel-
opment tool that no serious web designer can do without. Whether you’re a relative newcomer or
a long-time design professional, Dreamweaver is an ideal solution; along with offering advanced
web standards-based design tools, it enables you to create dynamic websites. Graphic designers feel
at home using Design view, whereas coders can work in Code view to create documents that imple-
ment all manner of web technologies. Those who like a little of each can combine the two views.

Dreamweaver MX 2004 massively improved the application’s ability to deal with web standards,
centering its workflow around Cascading Style Sheets (CSS), a technology that enables designers
to create low-bandwidth, accessible, flexible, cutting-edge layouts. Dreamweaver 8 takes this a stage
further, cementing workflow firmly in the area of web standards and providing a number of
massively useful visual tools for working with CSS-based layouts.

If you’re a little concerned about all this, don’t be. CSS makes it much easier for designers to create
and tweak page layouts—often site-wide—just by editing a few rules in a single CSS document.
Dreamweaver 8 makes this cutting-edge technology accessible to all designers, no matter what their
level of expertise.

All in all, Dreamweaver 8 is the perfect application for web designers, no matter what type of site
they want to create. Because it’s a fantastic visual design tool with support for powerful server-side
technologies, it enables you to create great-looking dynamic websites efficiently and effectively.
Now you can have it all, and the Foundation Dreamweaver series from friends of ED shows you how.

The aim of this book
This book provides you with a thorough foundation in the use of all the essential design-oriented
features of Dreamweaver 8—and even some of the lesser-known elements. You’ll learn how to work
with Dreamweaver 8 to create typography, work with images, create the basics of page layouts, and
then combine all of these things to create cutting-edge website designs. With the book’s modular
nature, you will be able to “mix and match,” combining elements from various chapters to create
your own work.

Although this entry in the Foundation Dreamweaver series is primarily design-oriented, it doesn’t
just concentrate on graphic design. Within, you’ll learn everything you need to create great-looking,
fast and efficient static websites: in addition to layout tasks, we’ll explore how to get feedback from
a website and how to work with Dreamweaver 8’s excellent template facilities, thereby speeding up
workflow and site maintenance. Furthermore, general site concept and management techniques will
be outlined, giving you the full picture about how to create and maintain a site.
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By the time you reach the end of the book, you will be ready to deploy your skills developing
modern, standards-compliant sites to meet a variety of needs.

What you’ll need
You’ll need a copy of Dreamweaver 8 installed, and you’ll also need to know your way around your
preferred operating system—either Windows (XP or 2000) or Mac OS X 10.3 or higher—and be
comfortable creating folders, naming files, and so on. Which platform you use is up to you. In the
book, I’ll be working with the Mac version of the application, but it works in exactly the same way
as the Windows version, and keyboard shortcuts will be provided for both systems (and in the very
few areas where there are differences, I’ll be sure to point them out). You also need an Internet
connection if you want to download the source files for this book.

Remember that if you need additional help while working your way through the book, the friends
of ED forums (www.friendsofed.com/forums) are there for free technical support. Help is close
at hand!

Conventions
In order to ensure this book is as clear and easy to follow as possible, only a few layout styles have
been used:

Important words or phrases appear in bold type.

Words and phrases that appear onscreen (including Menu ➤ Commands) are presented in
one font, and code, filenames, and hyperlinks, such as www.friendsofed.com are presented
in another. 

One or more lines of code are set separately:

Blocks of code appear in this style

Steps in the exercises are laid out like this:

1. Open up Dreamweaver 8.

2. Save your file as index.html.

3. And so on . . .

You’ll notice that I don’t make any recommendations regarding what platform to use,
and this is for good reason. Both PCs and Macs are equally capable of creating the kind
of websites we’ll be working on in this book, hence my decision to be platform-neutral
throughout. Dreamweaver’s authors have made my job easier by continuing to unify
the application’s interface across both platforms, so the tutorials and information in
this book will be equally useful to you whether you use a Mac or PC.
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Download files
All source files for the completed versions of the exercises in this book are available for download
at www.friendsofed.com. Feel free to experiment with them, and if things go wrong with your
version, take advantage of Dreamweaver’s ability to compare your file with the completed one—it
often helps. Dreamweaver 8 also offers an option to print your code (File ➤ Print Code)—print out
your version and the downloaded one, clearly mark any differences, and change your version
accordingly.

friends of ED
For news, books, sample chapters, downloads, author interviews, and more, point your browser to
www.friendsofed.com. Be sure to sign up for our monthly newsletter to get all the latest on
upcoming books.

You can also visit our support forums at www.friendsofed.com/forums for help with any of the
tutorials in this book, or just to chat with like-minded designers and developers. You’ll find a variety
of designers talking about all manner of tips, tricks, and techniques, and they may be able to
provide you with help, ideas, insights, and inspirations.

Even if you don’t have a problem, email feedback@friendsofed.com to let us know what you think
of this book—we’d love to hear from you! Whether it’s to request future books, ask about friends
of ED, or tell us about sites you’ve created after reading this book, drop us a line!

Please note that all photographic images contained within all of the
tutorials shown in this book remain the copyright of Craig Grannell
(who can be contacted via www.snubcommunications.com) and should
not be reused without written permission.

When code is too long to fit on one line, you’ll see a code-continuation character (➥)
to show that the next line of code is on the same line in Dreamweaver. If you come
across such a symbol, don’t go pressing the Enter key just yet.
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Chapter 1

In this chapter . . .

Introducing the Internet and web design

Why you should design a website

Organizing and planning web page content

Introducing web standards
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About the Internet
The Internet’s rise has been nothing short of meteoric. We may take it for granted today, using it for
all manner of tasks, but just over ten years ago few people had even heard of the Internet, let alone
used it. For businesses and individuals, the Internet is now often the communication medium of
choice, enabling them to interact with the world. But the Internet’s origins were more ominous and
rather different from the ever-growing, sprawling free-for-all that exists today.

Back in the 1960s, the American military was experimenting with methods by which the U.S. authori-
ties might be able to communicate in the aftermath of a nuclear attack. The suggested solution was to
replace point-to-point communication networks like the telephone with a system that was more
robust. They decided to create a network and to send packets of data from one node of the network
to the other in a sort of relay race. This meant that information could find its way from place to place
even if certain sections of the network were destroyed. Despite the project eventually being shelved
by the Pentagon, the concept itself lived on, eventually influencing a network that connected several
American universities.

During the following decade, this fledgling network went international and began opening itself up
to the general public. The term Internet was coined in the 1980s, and the Transmission Control
Protocol/Internet Protocol (TCP/IP) was invented—the networking protocol that makes possible com-
munication between computers running on different systems. For the first time, corporations began
using the Internet as a means of communication, both amongst themselves and also with customers
who were clued in to this exciting medium.

Despite the technology’s healthy level of expansion, the general public remained largely unaware of
the Internet until well into the 1990s, when a combination of inexpensive hardware, the advent of
highly usable web browsers such as Mosaic, shown below, and improved communications technology
saw an explosion of growth that continues to this day. Initially, only the largest brands dipped their
toes into these new waters, but soon thousands of companies were online, enabling customers all over
the globe to access information, and later even to shop online. 

2

CHAPTER 1



Home users soon got in on the act, too, once it became clear that the basics of web design weren’t
rocket science, and that everyone could do it—all they needed was a text editor, an FTP client, and
some web space. Therefore, unlike most media, the Web is truly a tool for everyone, and in many
countries the Internet has become the medium of choice, supplementing—if not supplanting—print
and video.

So, from its obscure roots as a concept for military communications, the Internet evolved into an
essential tool for millions of people, enabling them to communicate with each other, research and
gather information, telecommute, shop, play games, and become involved in countless other activities
on a worldwide basis. But websites don’t appear by magic—someone has to create them . . .

A brief history of web design
Mosaic was the Web’s first “killer app,” the one that finally enabled non-computer-literate people to
simply point and click to browse. It appeared on both Windows and Macintosh computers and opened
up the Web to a whole new audience—one that had wildly different expectations than the primarily
technically oriented souls who’d been using the system until that time. Now, people weaned on mag-
azines and advertising demanded similarly visually appealing, usable content from the Web, but the
process was long and—for the designers at least—difficult.

Browsers have always been the sticking point with regards to what’s possible in web design, and early
browsers were particularly limited in what they could display. Early sites tended to be strictly static
affairs, perhaps with the occasional graphic to break things up. The Web was also a very boring place:
Flash and online videos were some way off, and connection speeds were extraordinarily slow com-
pared to what the majority of users are using today.

The mid-1990s was when things started to gain speed. A group of web gurus founded the World Wide
Web Consortium (W3C—see www.w3.org/Consortium), providing technical specifications for web
infrastructure. Over 35 such specifications were released in its first five years of existence. In 1995,
Netscape 2 exploded onto the scene, introducing the world to frames, LiveScript (soon to be renamed
JavaScript), and plug-ins like RealPlayer. Multimedia content was becoming a reality online, although
postage-stamp-sized video was pretty much all anyone could cope with, due to the fledgling com-
pression formats and slow connection speeds of the day. It was around this time that Microsoft
noticed what was going on, swiftly following up its half-hearted Internet Explorer with versions 2 and 3.
The latter version was free, and it matched Netscape’s latest release for features, and offered rudi-
mentary style sheet implementation. Sites gradually started using many of the new features, although
some were over-used: frames became ubiquitous, despite the massive problems they caused search
engines and users alike; gaudy text became the norm, as did some fairly hideous fonts. However, many
designers got around the limitations and avoided the fads, and this period saw some of the first really
great designs on the Web.

In its quest for world domination, Microsoft next bought WebTV Networks, and then practically
welded Internet Explorer to Windows, which usurped Netscape as the default Mac OS browser.
Microsoft and Netscape traded blows, each company’s browser offering its own Cascading Style
Sheet (CSS) standard and Document Object Model (DOM), causing a headache for designers, who
had to effectively produce a version of each site they were working on for each browser, due to the
major differences in anything other than the most basic features.
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At the same time, web design applications finally came of age, including the increasingly impressive
Dreamweaver, opening up web design to the masses, who no longer had to have encyclopedic knowl-
edge of HTML to create a site. Also, the Web Standards Project (WaSP—see www.webstandards.org)
started campaigning for browser manufacturers to support web standards, claiming that it would oth-
erwise soon be impossible to create sites that would be accessible on a variety of platforms.

Around the turn of the century, Netscape pretty much imploded, conceding defeat to the increasingly
dominant Internet Explorer and releasing half-hearted, buggy browsers that made few friends.
However, both Netscape and Microsoft, along with the increasingly popular Opera, finally introduced
relatively thorough standards support, and design on the Web continued to improve, often aping min-
imal magazine style. Notably, Macromedia’s Flash Player plug-in was now installed by default, and
estimates suggested that more than 80 percent of users could view Flash content. Many designers
dropped HTML in favor of Flash. Some created beautiful, subtly animated, and highly usable Flash
content; others saw fit to inflict eye candy on everyone. (Flash intros, complete with “skip intro”
buttons, became so common that they eventually spawned a parody site, which can still be accessed
at skipintro.nl/skipintro.) Unfortunately, the bubble soon burst: the meteoric rise in popularity of
the Internet had birthed hundreds of web design companies, many of whom charged a fortune for
their services. The infamous “dot bomb” crash put paid to that, removing a shockingly large number
of companies from the scene, and giving a rather harsh slap of reality to the entire industry.

Every cloud has a silver lining, though, and the last few years have perhaps been the best for web
design. In many ways, the medium has grown up. Most professional designers now know which tools
to use for which job, leading to stunning sites that combine standards-compliant mark-up for content
with CSS for styling, and occasional subtle use of Flash for animation, video, and interactive elements.
Special emphasis is placed on usability and accessibility, ensuring sites are usable and accessible by
all, and designers now understand that this needn’t come at the expense of visual design. And most
designers are finally aware that content is king. 

The onset of broadband made online audio and video feasible for the first time. Browser manufactur-
ers began to play ball with regards to standards, and the relatively new Firefox (created from the ashes
of Netscape) has even managed to bite into Internet Explorer’s supposedly unassailable market share.
While there are still bugs and omissions here and there, you can now author a web-standards-compliant
site and know you’ll only have to tweak a few things to get it working in a huge number of devices.
The Web Standards Project’s attention had also turned to developers of web design applications, and
Macromedia was one of the first companies to wholeheartedly embrace standards, basing Dreamweaver’s
workflow around CSS (something that continues apace with Dreamweaver 8).

Accessibility is a much-used word in the web design world these days. It refers to
the practice of ensuring that a site is accessible to everyone, including, for
instance, those people using screen readers. Various techniques are available to
help make a site more accessible, and some of these will be explored in this book.
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What the future will bring, no one knows. However, this book aims to ensure that you’re armed with a
strong understanding of the medium and of Dreamweaver, so you’ll be ready to tackle whatever the
Web evolves into next. 

Creating a website
Surprisingly few designers ask themselves why they are creating a website, but it’s a question that
should be asked at the beginning of every project. Before delving into your digital box of tricks, it pays
to plan and prepare. The worst websites online—those that are unfocused, unusable, or just plain
bad—are often the product of poor planning. In most cases, such problems can be overcome by tak-
ing the time to work out what’s best for your site and why you’re creating it in the first place. 

Most of the questions you need to ask are generic and can be applied to the majority of projects
you’re likely to work on:

What is the purpose of the website?

Who will visit the site?

How will this target audience affect your approach?

Is there a client involved, and if so, what are its needs?

What content will the site contain?

From where will the content be sourced?

How will the site be structured?

What will the site look like?

When is the deadline?

These aren’t the only questions you should ask yourself, but they’re a good start. Also bear in mind
that there are rarely any wrong answers, but whatever you discover may help consolidate ideas. Let’s
take a look at some of the questions in more depth.

What is the purpose of the website?
A successful site’s purpose is often reflected in its design. For instance, Play.com’s aim is to sell as
much product as possible to as wide a range of customers as possible. Therefore, the structure and
navigation of the site—if you’ll pardon the expression—is idiot-proof. The navigation is intuitive, and
searches that take you deep into the site are easily available. The visual design is somewhat bland and
inoffensive, so while it won’t excite anyone, it won’t annoy them either.  
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Typically, successful content-oriented sites have a similar approach: Wired.com and BBC News
(http://news.bbc.co.uk/) have thousands of pages, and yet all information can easily be found.
However, while both sites partially adhere to their corporate branding, neither would be considered
“exciting” design.

At the other end of the spectrum, you’ll find the likes of Yugop.com, shown next. This is an experi-
mental Flash-based website, yet the interface still makes perfect sense, enabling you to rapidly access
the content. This is, in many ways, proof that even if your content is outside the mainstream, you
needn’t forego usability. However, because this site’s main aim is to showcase content, the navigation
is very succinct, and the majority of the available space is given over to presenting the various anima-
tion projects.
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Ultimately, you will need to decide what the focus of your site is, and ensure that it’s prominent and
that all the content is easy to access.

Who will visit the site?
The worst designers are those who only design for themselves. This almost always results in self-
indulgent and inappropriate results. If you’re working for a client, find out about the expectations of
its audience and design accordingly. You needn’t compromise every step of the way, but you need to
ensure that a site’s visitors will be in-tune with whatever it’s trying to get across and won’t be put off
by how the site appears. If appealing to a very wide audience—everyone from the clued-up techie to
the new-to-technology granny— keep things simple and toned down. Ensure that your site is simple
to use and navigate, and that it’s obvious where each type of information is to be found. If appealing
to a very specific audience, find out what they want. For instance, a site for children’s book illustration
should be appealing to parents and small children, and is unlikely to require harsh colors, bold angles
and hours of video and animation footage. Similarly, a gaming site is going to need high-impact graph-
ics, access to screen shots and gaming footage, but probably not a pastel color scheme and introduc-
tory page about the organization itself (gamers tend to want to get right to the content).
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Is there a client involved, and what are its needs?
Most designers create work for others, but even when you’re creating work for yourself, the ultimate
client remains the audience. Often, projects become a delicate balancing act, harmonizing your ideas,
those of your client, and the expectations of the audience. 

Chances are, ideas will keep changing along the way, often because of external factors. You might have
a preference for certain colors or layouts, but if most of your audience disagrees, you may need to
rethink. Be flexible: just because clients are not artists, you shouldn’t disregard their opinions. Of
course, the dynamic nature of the Web can make such changes relatively quick and cost-effective to
put into practice, especially when using the techniques we’ll be covering in this book. By comparison,
if a print brochure needs changing, the whole thing must be reprinted, or a supplement bolted on.
Such a print job won’t be any cheaper the second time around if changes are made. However, for a
web site, this isn’t the case—the existing content can easily be edited. For example, correcting a major
typo on the introductory page of a printed catalogue might cost thousands, or have to be ignored
(due to cost), but correcting the same thing on a website may only take a few minutes and effectively
cost nothing.

Turnaround time is also potentially much more rapid online. If the site is your own, you can make
changes almost immediately. If you’re not the client, you’ll need to get approval from whoever is in
charge, but the changes are still likely to happen fairly rapidly. Perhaps the best advice I can offer
about working with clients is to communicate constantly. Never assume you know what a client wants,
or that a client knows exactly what you mean, unless things are explicit. Write everything down, get
written specifications, and draw up a contract saying exactly what the client can expect and when. 

Set milestones in the project, which the client will have to sign-off for (and maybe pay a percentage
of the overall costs for), such as after the visual design, site design, and content addition and upload.
Make it clear that if the client changes the specifications at any point, there may be charges for alter-
ations if they’re substantial. And keep communicating throughout; the worst web sites usually come
about because those involved didn’t talk to each other about their needs and those of the end users.

What content will the site contain?
Content is king, and you need to think about what content the site will contain before you even con-
sider the visual design. For instance, there’s little point in creating a small, graphics-heavy template if
it turns out your client has no images and plenty of text for the website. 

You need to ensure the client understands what content is required and in what format it should be
sent to you. When working for or with a company, find out who has the responsibility for supplying
you information, and set dates when it should be sent (dates well before your final deadline)—if a
client doesn’t send you content on time, you shouldn’t be expected to turn around the site’s design by
the previously agreed deadlines. Also, ensure that you specify specific file types and settings (such as
resolution)—there’s little worse in the world of web design than having to rapidly produce a website
after receiving a CD full of images that you cannot open or use.

Keep in mind that copyright exists on the Web the same as everywhere else, despite what some
people might think. Do not just grab a load of images or text from other websites unless you have
written permission from the copyright owner (who is not necessarily the site’s creator) to do so.
Failure to do this could mean anything from a harsh email to a lawsuit.
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How will the site be structured?
Most sites have some sort of “home” or “news” or “introduction” page, an “about” page describing the
site, a “contact” page indicating how users can get in touch, and any number of pages containing
the majority of the site’s content (typically products or services for a commercial site). Overly compli-
cated structures tend to wreck websites, so keep everything as simple and logical as possible, group-
ing categories and pages in a consistent and coherent manner. 

Wherever possible, make all top-level category pages accessible from a central location (such as a nav-
igation bar) and keep subpages to a minimum. In some cases, this can be achieved by the clever use
of layout.

As mentioned earlier, the site should be straightforward to use, which means stripping back the navi-
gation area to the bare essentials, and making good use of succinct copy. Icons should be avoided—
after all, the word “contact” is unambiguous, but a picture of an envelope could mean “mail,” “email,”
or several other things.

When is the deadline?
This is an important question for any project. A wonderful masterpiece of design, with a beautiful,
highly animated interface is of no use to a client if you’ve only had time to create the home page. If
deadlines are too tight for what’s been asked of you, talk to the client about it. If the client is you, give
yourself a good talking to, and try to be more realistic about deadlines in the future.

One thing that should always be avoided is “under construction” pages. They look shoddy and unpro-
fessional at best. If an area of a site is not going to be ready for the launch date, remove the links to
it (which is relatively simple when using the technologies outlined in this book). Even better, if the site
is new, delay its launch and put up a small holding page containing contact information and a small
message saying when the completed site will be online. (It should go without saying that you must
stick firmly to whatever deadline you’ve published for all the world to see.)

In any case, you should be able to make reasonable deadline estimates based on previous jobs. If in
doubt, try to deal with the content (sourcing, structure, and formatting) first, and then with the
design. You can spend an age messing around with visual design, but if there’s no content, any such
fiddling is academic. 

Gathering and organizing content
Gathering content is one thing, but keeping it organized is something else entirely. There are plenty of
people who claim they work better in a jumbled mess, but this doesn’t really work with computers,
even when taking into account the “find file” functions built into Windows and the Mac OS. After all,
you may not remember the filename of something you’re searching for, especially when working with
images from digital cameras, which may have such “useful” filenames as 02032045023450.jpg. Logical
organization and naming of all your files means you should be able to find what you need at any point
during a project.
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Before getting any content, set up a folder structure on your
hard drive to store everything in. The structure shown here isn’t
in any way set in stone, but it is a general guide that you can
adapt to each project as you see fit. 

As you can see, the project folder has two folders within it, the
second of which is the local copy of the website. (Rather than
just calling this “web,” it should include the project name; it
soon becomes difficult to find a specific web folder when you
have dozens of folders called “web” on your hard drive.)

The other folder is called Development, and it houses all the
files you might need to complete a website, including original text (perhaps in the form of Word, text,
or RTF documents), graphics (such as logos), layouts, photographs, and the site map (for reference
purposes). In the photographs folder you can keep full-quality copies of your photos, so if you need
to resize one at a later date, you can do so from the original, without having to search various other
locations to find the relevant images.

Finally, note the backups folder. Web design can be a tricky business, so it’s a good idea to take back-
ups of your local web folder on a regular basis. If you suddenly find that something stops working, you
can revert to (or at least make a comparison with) your most recently working version.

Creating a site map
A site map is essentially a diagram that provides a structural overview of a website. You can use appli-
cations such as Adobe Illustrator, Macromedia Freehand, Microsoft PowerPoint, and others to make
them, or you can use good old squared paper and a pencil. Most site maps are structured in a similar
fashion to the diagram here:

Underscores are used instead of spaces in the folder set aside for the website files
(web_project_name) because some scripting languages require this. While such scripts
aren’t used in this book, it’s a good habit to get into the naming convention shown.
Note that for “source” files (photographs, text, and so on), this doesn’t matter—they
can be placed within folders that have spaces in their names.
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The home page is the initial page users will access, so it is at the top of the tree. Main sections are then
listed horizontally underneath. Perhaps, in tandem with the home page, these will form the basis for
the site’s navigation bar (or at least the most prominent parts of it). Underneath each section are
listed the pages found within. For larger sites, these may actually be subsections, with more pages
being listed under them.

Introducing web standards
Before we start with Dreamweaver, let’s look briefly at the two web standards we’ll be using most
often in this book. While Dreamweaver’s interface largely enables you to avoid hand coding, you’ll be
better off if you understand some of the concepts behind web standards such as XHTML and CSS, not
only for when you have to tweak the code Dreamweaver produces, but also when you’re using some
of the application’s dialog boxes, which may be rather cryptic if you don’t understand the terminology.

XHTML
No, a rogue “x” hasn’t snuck in front of the preceding heading—Extensible Hypertext Markup
Language (XHTML) is HTML reformulated in XML, providing greater interpolation with numerous
devices. Because XHTML is a more recent standard than HTML, it’s recommended that you use XHTML
wherever possible—indeed, Dreamweaver 8 defaults to XHTML when you create a new web page via
File ➤ New. Note that despite the change in name, the file extension remains the same (.html, or .htm
if you like using archaic 8.3 DOS conventions).

CSS
Cascading Style Sheets (CSS) is the W3C standard for defining the visual presentation for web pages. 

HTML was designed as a structural markup language, but the demands of users and designers encour-
aged browser manufacturers to support and develop presentation-oriented tags. These tags “pol-
luted” HTML, pushing the language to focus more on decorative style than logical structure. Its
increasing complexity made life hard for web designers, and source code began to balloon for even
basic presentation-oriented tasks. Along with creating needlessly large HTML files, things like font tags
created web pages that weren’t consistent across browsers and platforms, and styles had to be applied
to individual elements—a time-consuming process. 

By comparison, CSS enables you to separate design and presentation from content—XHTML deals
with the basic structure of a page, and a separate CSS document is used for the site-wide application
of visual presentation (including element margins and padding, backgrounds, borders, and so on).

As is often the case within this book, I’m providing ideas rather than
concrete guidelines. This most definitely isn’t the only way of creating
a site map; whatever method you end up using, ensure that you under-
stand it well, and that it’s easy to explain to a potential client.
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Although many designers are aware of CSS, relatively few use it for anything more than styling fonts.
However, Dreamweaver 8 makes it relatively easy to create CSS-based web page layouts, as you’ll see
during the course of this book. That said, Dreamweaver doesn’t do quite everything for you, and
something you need to know is which CSS selector type to use in each case when creating a CSS rule
(these are outlined in Chapter 4).

Summary
In this chapter, you’ve learned about how the Internet came to be, and also many important things
you need to do before working with Dreamweaver. You’ve also read overviews on XHTML and CSS—
technologies that will prove essential as you work your way through the book. 

In the next chapter, we’ll take a look at Dreamweaver itself, so you can learn how to create a new doc-
ument and you can familiarize yourself with the application’s interface.
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What is Dreamweaver?
Dreamweaver is a software application that enables you to create web pages. Version 1 was released
nearly a decade ago, in 1997, and since then Dreamweaver has become the leading application in the
field. This is largely due to three essential factors:

Dreamweaver’s interface enables people at all levels to understand the application, regardless
of their preferred methods of working.

Dreamweaver is powerful enough to enable you to create almost any type of website.

Dreamweaver has always been one of the first applications in its field to embrace and integrate
new technologies.

Dreamweaver 8 includes many new features; for instance, it builds on Dreamweaver MX 2004’s CSS-
based workflow by streamlining working with that technology and by greatly enhancing Design view to
show outlines of CSS boxes. The program caters to graphic designers by providing guides and zoom
tools, enabling more precise layout, and hand coders will be happy to discover the new Code View
toolbar, which provides quick access to commonly used commands. 

Of course, Dreamweaver 8 still excels at integrating with other Macromedia products—Fireworks, Flash,
and FreeHand—and it enables you to customize your workspace (and save different workspace layouts).

Don’t worry if you’re new to Dreamweaver, because we’ll be starting from the very beginning. And if
you’re already familiar with the application, you’ll still learn plenty, because the application has
evolved from previous versions and we’ll be using the newest techniques rather than legacy methods.

Creating a new document—the Start Page
The first thing that pops up when you open Dreamweaver 8 is the Start Page.

Your first instinct might be to check the Don’t
show again check box, especially if you’re a
seasoned pro, but it’s worth leaving it alone
for a while. Not only does it provide single-
click access to various file types via the Create
New column, but it also provides easy access
to built-in sample sets, and the Dreamweaver
Exchange.
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The Start Page also provides rapid access to items you’ve recently worked on, via the Open a Recent
Item column. While many applications (including Dreamweaver) contain similar functionality via
File ➤ Open Recent, the Start Page makes this process just that little bit faster, and those few saved
seconds for each opened file soon add up.

Should you click Don’t show again and later change your mind, the Start Page can be reactivated by
going to Edit ➤ Preferences (Dreamweaver ➤ Preferences on Mac), selecting General, and then
checking Show start page, found in the Document options area.

Choosing a document to work with
Click the More option in the Start Page’s Create New column, and the New Document dialog box
appears. (This can also be accessed via File ➤ New.) There are two tabs at the top—General and
Templates. The first provides access to built-in examples and blank documents, while the latter enables
you to access any templates you’ve created (see Chapter 10 for more on Dreamweaver templates).

The Dreamweaver Exchange, found at www.macromedia.com/cfusion/exchange/index.cfm,
is a useful repository for free or affordable components that can make it easier for you to add
functionality to your web pages. Elements for download are usually built by members of the
design community, and there’s no doubting that it’s an essential resource for any Dreamweaver
user. However, beware of downloads that only function accurately in specific browsers or on
specific platforms—any such components should generally be avoided. After all, good websites
work in all browsers—imagine a scenario where a potential client cannot use your site, or part
of your site, because it only works in one browser, and they use a different one. You will almost
certainly lose that business, because a client may find it easier to find a competitor rather than
go to the hassle of switching web browsers. Using web standards, as we will throughout this
book, means such a scenario shouldn’t happen.
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